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Overview
This guide is intended for new eGrants users to learn how to set up their computer to access eGrants, 
access eGrants to fill out grant applications, report on program progress, view grant information, and 
perform other grant-related activities.

Organization
This guide is organized into the following chapters:

 Obtaining Access to eGrants explains how to request access for the web site.

 Setting Up Your Computer explains how to set up your browser, Acrobat Reader, and 
other computer properties to best access information from eGrants.

 Viewing Grant Opportunities explains how to use the Grant Opportunities web page to 
view information about all TEA grants, including ones in eGrants.

 Working in eGrants explains how to use the computer interface to view grant information 
for your organization and to access grant-related materials.

 Applying for a Grant explains how to access and fill out grant applications.

 Managing the Application explains how to amend or revise an application, complete 
progress or compliance reports, view the document library, or exit eGrants.

eGrants Capabilities
eGrants is the online grants management application for the Texas Education Agency (TEA). eGrants 
has the following capabilities:

 Allowing the public or targeted audiences to view postings of available formula and 
discretionary grant monies

 Viewing complete information about grants in eGrants

 Initiating, preparing, and submitting completed grant application packages on the web

 Completing compliance, progress, and evaluation reports

 Processing amendments

 Viewing approved applications and amendments

Relevant Links

TEA Office for Planning, Grants & Evaluation web site at http://www.tea.state.tx.us/
index2.aspx?id=7775

Grant Opportunities page at http://burleson.tea.state.tx.us/GrantOpportunities/
forms/
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 Viewing a Notice of Grant Award (NOGA)
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Obtaining Access to 
eGrants

This chapter outlines the security roles and privileges set up for eGrants and explains how to request 
TEA secure environment (TEASE) access and a Vendor ID. All external users must have TEA SE access 
and a Vendor ID to access the system.

Requesting a Vendor ID
Before requesting that a Vendor ID be assigned by the Office of the Texas State Comptroller, consult 
with your business office to ascertain whether your organization has previously been issued a Vendor 
ID. If your organization has not been issued a Vendor ID, you can obtain one by completing the Texas 
Application for Payee Identification Number. A link to the form is included in the Relevant 
Links.

1. Complete the entire Texas Application for Payee Identification Number form lines 1–15. Be 
sure to provide an individual work email address. Do not use a group email address.

2. Sign the Texas Application for Payee Identification Number form on line 14.

3. Fax the form to eGrants Support at the number listed in Requesting TEASE Access.

Requesting TEASE Access
To access eGrants, all external users of the eGrants system must complete a TEASE Request for 
Access form to be approved by TEA. TEASE access will provide you with a username and password to 
access eGrants. 

On the Request for Access form, you must provide the Vendor ID number assigned to your 
organization by the Texas Comptroller’s Office. Links to the TEASE Request for Access form and the 

Relevant Links

Request form for TEA SE access:

 Online form for employees of school districts, education service centers (ESCs), 
and open-enrollment charter schools at https://seguin.tea.state.tx.us/appsng/
um/apply.aspx

 Paper form for all others at http://ritter.tea.state.tx.us/forms/tease/
egrants_ext.htm

Texas Application for Payee Identification Number at http://
www.window.state.tx.us/taxinfo/taxforms/ap-152.pdf

TEASE logon screen at https://seguin.tea.state.tx.us/apps/logon.asp

eGrants TEASE information center at http://www.tea.state.tx.us/opge/egrant/
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Texas Application for Payee Identification Number are included in the Relevant Links. For 
instructions on completing the Texas Application for Payee Identification Number, see Requesting a 
Vendor ID.

If you are an employee of a school district, an ESC, or an open-enrollment charter school whose 
superintendent has User Admin+ to perform online approval, you must fill out the form online. The 
paper form will not be accepted. All others can fill out the paper form. This section includes 
instructions for both forms.

Applying Online

If you are an employee of a school district, an ESC, or an open-enrollment charter school whose 
supervisor has User Admin+ to perform online approval, you must apply for eGrants access using the 
online form. To apply online, do the following:

1. Go to the online form at https://seguin.tea.state.tx.us/appsng/um/apply.aspx.

2. Under Select Application, select eGrants Production.

3. Complete the form. Information about the roles and permissions is available from within the 
application.

4. Click Submit. The form is forwarded to your superintendent for submission before being 
forwarded to TEA. Once the request is approved and processed, you will receive an email with 
your username and password.

Completing the Paper Form

If your organization is nonprofit, Communities in Schools, college, or university or your school 
supervisor does not have User Admin+ to perform online approval, you must apply for eGrants access 
using the paper form. To apply using the paper form, do the following:

1. Click on Apply for eGrants Logon on the eGrants Toolbox web page or select the paper 
form at http://www.tea.state.tx.us/forms/tease/egrants_ext.htm.

2. Complete the form. See Understanding TEASE Roles and Privileges for information about the 
TEASE roles.

3. Print the form.

4. Obtain a signature from your superintendent or chief executive officer.

5. Fax or mail your TEA SE Request for Access form to the following:

eGrants Support 
Texas Education Agency 
Office for Planning, Grants, and Evaluation 
1701 N. Congress Ave 
Austin TX  78701-1494 
Fax (512) 463-9564
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Understanding TEASE Roles and Privileges
If you are a user of the eGrants system, you will request and will be assigned a role when you complete 
a TEA SE Request for Access form. Functionality that is not included in the assigned role will not be 
visible or will be visibly disabled. Each role has been assigned specific privileges to perform specific 
tasks in the eGrants system. The table below illustrates the roles that can be assigned.

Role Name Role Privileges Listed by System

Grantee Official
Requestor/Grantee authorized official with 
authority to submit (i.e., sign) the grant 
applications and bind the applicant in a 
contractual agreement (usually the district 
superintendent or executive director); has all 
privileges: can write, certify, and submit 
applications, compliance reports, and 
expenditure reports

eGrants

View program summary, guidelines, and 
instructions

View, create, save, and print grant applications 
(including designation forms and supporting 
forms)

Certify and submit grant applications and 
amendments (including designation forms and 
supporting forms)

View NOGA

Reporting

View, edit, save, and print compliance, prog-
ress, and evaluation reports

Certify and submit compliance, progress, and 
evaluation reports, and special collections 
reports 

Grantee Manager
Requestor/Grantee manager (local project 
manager or business manager; this is usually 
the primary and the secondary program contact 
as well as the business manager)

eGrants

View program summary, guidelines, and 
instructions

View, create, save, and print grant applications 
(including designation forms and supporting 
forms)

Certify and submit grant applications during 
negotiation

View NOGA

Reporting

View, edit, save, and print compliance, prog-
ress, and evaluation reports

Certify and submit compliance, progress, and 
evaluation reports and special collections 
reports
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Grantee Staff
Requestor/Grantee staff (includes program staff 
employees or contract personnel and business 
office staff who only need to view the application 
but need to write or edit the compliance, 
progress, or evaluation reports)

eGrants

View program summary, guidelines, and 
instructions

View and print grant applications (including 
designation forms and supporting forms)

View NOGA 

Reporting
View, edit, create, save, and print compliance, 
progress, and evaluation reports, and special 
collections reports 

Grantee Writer/Editor
Grantee Writer/Editor—Requestor/Grantee 
writer/editor (employee or contracted personnel) 
assigned to write and edit the application

eGrants

View program summary, guidelines, and 
instructions

View, create, edit, save, and print grant appli-
cations (including designation forms and sup-
porting forms)

View NOGA 

Grantee Viewer
Requestor/Grantee viewer (staff with read-only 
access to grant applications and compliance, 
progress, and evaluation reports); cannot take 
any action on behalf of the applicant

eGrants

View program summary, guidelines, and 
instructions

View and print grant applications (including 
designation forms and supporting forms)

View NOGA

Reporting
View and print compliance, progress, and 
evaluation reports and special collections reports

ESC Viewer
ESC staff with view rights to grant applications 
and reports except for competitive grants

eGrants

View program summary, guidelines, and 
instructions except for competitive grants

View and print grant applications (including 
designation forms and supporting forms) 
except for competitive grants

Reporting
View and print compliance, progress, and 
evaluation reports, and special collections 
reports except for competitive grants

Role Name Role Privileges Listed by System
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Setting Up Your Computer
This chapter shows you how to set up your computer defaults to ensure clear navigation and proper 
functionality of the eGrants system. This chapter also provides information about supported hardware 
and software and about eGrants availability.

Introduction

Supported Platforms

The required browser is Internet Explorer. Using Netscape may cause eGrants not to perform 
properly. If Internet Explorer is not on your computer, we recommend that you have your network 
administrator install it. However, you can download it free of charge at http://
windows.microsoft.com/en-US/internet-explorer/downloads/ie.

eGrants supports only the systems and browsers listed below.

Supported Operating Systems

Windows 7

Supported Browsers

Internet Explorer 7.0 or 8.0.

Availability of eGrants

TEA runs full back-ups twice nightly starting at approximately 8:45 p.m. and ending at approximately 
9:30 p.m. In addition, transaction logs are backed up during the day at 5:45 a.m., 12:45 a.m., and 7:45 
p.m. During these periods, eGrants may not be available, or performance may be slow.

Relevant Links

Grant Opportunities at http://burleson.tea.state.tx.us/GrantOpportunities/forms/
GrantProgramSearch.aspx

Acrobat download at http://get.adobe.com/reader/

Note: eGrants will time out after 20 minutes if no activity has taken place. You 
will need to log on again. Please note that any information entered into schedule 
forms after the system has timed out will not be saved when you exit the system.
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Setting Up Internet Explorer
To increase efficiency while working within eGrants, TEA has a recommended set of Internet Explorer 
settings. The following sections will assist you in setting up Internet Explorer with the recommended 
configuration.

Checking the Browser Version

eGrants will work best if you use the correct browser version. Follow these instructions to check the  
version:

1. Open your Internet Explorer browser.

2. Select Help> About Internet Explorer.

 The following window appears: 

3. Make sure that the version of Internet Explorer is 7.0 or later.
PAGE 10 TEXAS EDUCATION AGENCY 



EGRANTS USER GUIDE REVISION 3.1
• If the computer has an earlier version, have your local computer support personnel 
upgrade your Internet Explorer version.

• If the computer has the correct version, click the OK button.

Setting Internet Options

Use these steps to set the Internet Options so that eGrants will operate correctly:

1. From Internet Explorer, select Tools> Internet Options.

The following window appears: 

2. In the Temporary Internet files pane, click the Delete Cookies button. 

3. Click the OK button to confirm that you want to delete the cookies.
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4. Click the Delete Files button to delete the temporary internet files. 

5. Click the OK button to confirm that you want to delete the files.

6. In the Temporary Internet files pane, click the Settings button.

7. Select the setting Every visit to the page.

8. Click the OK button.

9. In the History pane, reduce the Days to keep pages in history to 1.

10. Click the Advanced tab.
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11. Check the setting Reuse windows for launching shortcuts.

12. Click the OK button again, and the setup is complete.

Setting Up Adobe Acrobat Reader
Adobe Acrobat Reader is an essential support program for the eGrants system. Reader allows you to 
access and view important support documents, including the Application Guidelines, Schedule 
Instructions, and combined schedule sets that will assist you in navigating through the eGrant 
application process. The eGrants system also requires the use of Reader to view the grant application 
forms and compliance/evaluation reports via eGrants once they have been submitted using the 
document library. The following steps will assist you in setting up the Reader on your computer.

Verifying the Most Recent Version

Acrobat Reader is used to view the grant applications and their associated attachments in the 
document library. 

Click Start > Programs > Acrobat Reader on your desktop

 If Adobe Acrobat Reader is on your computer, do the following:

From the Acrobat Reader menu, select Help> About Acrobat Reader.

The following window appears:
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Version 6.0 or later is required to view PDFs from the document library.

 If Acrobat Reader is not on your computer, you can download it for free at http://
get.adobe.com/reader/. 

Setting Up Acrobat Reader

eGrants document library performs best using Acrobat Reader 6.0. Please upgrade your software to 
6.0 to increase performance. In addition, there is a setting in the Acrobat Reader that will speed up the 
process of opening large PDF forms.

1. Click on Edit > Preferences in your menu bar. 

2. Select Preferences > Accessibility.

3. Clear the checkbox in the Tab Order pane. Doing so will increase the speed in which PDF 
forms open.
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4. Click OK.

Turning Off the Acrobat Caching Feature

If you have Reader 6, you must turn off the caching feature as follows:

1. Select the appropriate one of the following menus:

• If you have Acrobat Reader 6 or 9, choose Edit>Preferences>Forms.

• If you have Acrobat 6, choose Edit>Preferences>General>Forms.

• If you have Acrobat 7, choose Edit>Preferences>Forms.

2. Clear Keep forms data temporarily available on disk. (Acrobat 5 does not have this 
feature.)

Turning Off Third-Party Popup Blockers
For the eGrants document library to work properly, disable all third-party pop-up blockers. A pop-up 
blocker is a browser add-in that prevents pop-up advertisements from appearing. It also prevents 
documents from being viewed from Content Services. 
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User-Installed Popup Blockers

Different pop-up blockers are disabled differently. There is one on the default TEA web site, but it is 
turned off by default. Any others are user-installed, so you are responsible for knowing what they are 
and how to turn them off.

The Google Toolbar Popup Blocker

From the Personal Work Manager, find the Google toolbar. Click the # blocked button and turn off 
Disallow pop-ups. Pop-ups will then be allowed whenever you are accessing sites on the same 
server.
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Viewing Grant 
Opportunities

Although not actually part of eGrants, the Grant Opportunities page provides useful information 
about grant opportunities, grants management, or grant application processes, including deadlines, 
links to instructions and guidelines, and so on. It is a page that anyone can view without a login. This 
page will be an important source of information about grant opportunities. Since you are responsible 
for keeping up to date on grant information affecting your organization, you may want to bookmark 
the site.

The page provides a centralized location for all TEA grant opportunities, whether the grant is available 
through eGrants or by paper application. The page is designed to provide more complete information 
about grant programs and to make it easier to find information about TEA grant processes than the 
previous pages.

Opening the Grant Opportunities Page
Select the Grant Opportunities page at http://burleson.tea.state.tx.us/GrantOpportunities/forms/
GrantProgramSearch.aspx.

The page is organized into panes that provide useful information about different types of TEA grants, 
including those that are in eGrants and those that are still in paper form.
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Getting Assistance
You can see Help files for this page by clicking Help? at the top of the page.

You can find general grant resources by clicking the TEA Grant Resources link at the top of the 
page.

Searching for a Grant Opportunity
To find information on grant opportunities for previous years, use the Search Options pane.

To search for a grant opportunity, do the following:

1. Select one or more of the following criteria:

• Name of the application

• Program or subject area

• Status of the grant posting

• State, Federal, or Other for type of funding

• Application type (discretionary competitive, discretionary noncompetitive, discretionary 
continuation, or formula)

• School year

• Availability or due dates

If you want to limit the search by dates, type in the dates of inclusion or select them by 
clicking on the calendar icon for either Availability Date (the date the application will be 
available to fill out) or Due Date (the date the completed application is due to TEA).
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2. Click Search.

3. If you get no results or do not get the results you anticipated, broaden or change your search 
criteria and try again.

To clear your selections and start again, click Clear.

Understanding the Search Results pane

If your search results return more than one grant, the Search Results pane provides information in 
the following columns:

 View: the magnifying glass icon, which you click to open the program details

 Name of Grant Application: the grant school year and program name

 Availability Date: the date the grant application is available for completion

 Due Date: the date the completed application is due to TEA

 Application Type: discretionary competitive, discretionary noncompetitive, discretionary 
continuation, or formula

 Availability: application available through eGrants (identified by the eGrants logo) or paper 
RFA

 Status: status of the grant dates (tentative, confirmed, or revised)

Viewing Grant Details
To view the details of a grant program, click on the magnifying glass icon next to the grant name in the 
Search Results pane. The Grant Details page appears.

Note: Dates are subject to change until the grant application is finalized. Check 
back periodically to get up-to-date information.

Note: If you pick a specific grant name from the Application Name field in the 
Search Options pane, the Grant Details page appears immediately.
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This page provides most of the information you need to apply for the grant, including links to the grant 
application documentation. 

The Grant Details page provides the following information, posted as it becomes available:

 Header: the name, year, and cycle of the grant program, its RFA number (for competitive 
grants), its SAS number, and a brief description of how to apply for the grant

 Program Information: a brief description of the program, a list of eligible applicants, and 
the authority under which the program was created

 Funding Information: the expected number of awards; the minimum and maximum allow-
able awards, if applicable; the cost sharing or matching requirement, if applicable; the amount 
of funds available for the project from each source; and the sources of the funds, and the grant 
start and end date

 Application and Support Information: pertinent information about the application, 
including the guidelines, instructions for completing the application, provisions, and selection 
criteria

To open any of these documents, click on the links.
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 Critical Events: a list of important dates, such as application and report due dates

 Contact Information: the names and contact information for program, funding, program 
evaluation, and electronic access issues.
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Working in eGrants
This chapter explains how to log on to eGrants and provides a tour of the eGrants user interface. It also 
provides instructions for basic tasks that you will need to perform in eGrants.

Logging On to eGrants
1. Log on through TEASE at https://seguin.tea.state.tx.us/apps/logon.asp.

The TEASE log on page appears:

Relevant Links

Planning, Grants, and Evaluation at http://www.tea.state.tx.us/
index2.aspx?id=7775

TEASE Logon at https://seguin.tea.state.tx.us/apps/logon.asp
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2. Type your username.

3. Type your password.

4. Click Continue.

If your login is successful, an application list opens. This list contains different items depending upon 
the programs for which you have requested TEASE access.

Note: If you try to log in and our system does not have your organization in the 
database, an error message appears: The system cannot find your organization 
information. Contact TEA by emailing eGrants@tea.state.tx.us. Please provide your 
complete contact information.

Check your login information again, and if it does not work, contact TEA.
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You can open eGrants one of three ways:

 By selecting it from the drop-down menu

The default in the pull-down menu is the first application that appears on the page under the 
pull-down menu box. Select eGrants from the list, then click the Launch button.

 By clicking on it from the list of applications below the menu

 By clicking on the eGrants logo. 

The first time each day that you log on, a security page appears. 

From this page, you can access other applications, change your password, change the verification 
information for your password, or log off. Press the Help button for more information.

Review the security assurances and click I Agree to continue.

Introducing eGrants
eGrants provides easy access to the grant applications for which your organization is eligible and to a 
great deal more useful information about grant programs in eGrants.
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The main menu at the left of the interface allows you to select either the Resources page or to exit 
eGrants.

 The main page of the new eGrants application is called the Grantee Profile. It provides a 
centralized view of all your eGrants activities, links to grants you have in process, and access to 
initiate new grant applications for which you are eligible.

 The Resources page returns you to the TEA Grant Resources page. 

The Grant Menu page appears after you select a grant program from the Grantee Profile. It 
provides links to the forms and applications available under that program, as well as information 
about that particular program.

Although all new eGrants appear in the new interface, older grants still have their original appearance. 
So, your views as you view grants will be different depending upon whether the grant is an older one 
However, the Grantee Profile and Grant Menu pages are the same for both types of grants. 
Eventually, all new grants will be converted to the new interface.

Getting Assistance
Besides this guide, eGrants provides several ways that you can get assistance in working with or 
completing an application:

 Look at the Help files: Click on the Help? button at the top of the page to see the complete 
Help files for eGrants. These Help files include a table of contents, index, and search facility for 
finding topics.

 Look at the Resources: Click on Resources on the main menu to view general grant 
resources.

 View the Legend: Look at the Legend on each page to understand the symbols used on that 
page.

 Click on the i icon: Click on the i icon to get information for a particular pane.

Click the X on the top border of the box to close it.
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 Click on the Help button: Click on the Help button for some panes where you might need 
additional instructions and guidance about statutes.

 View complete instructions or other program documents: Check the Program 
Information pane on the Grant Menu page (or on the Grant Opportunities page) for 
documents that may answer your questions. Click on a document to open it.

 View schedule instructions: Once you have selected a schedule in a grant application, click 
the Instructions button to view the instructions for that schedule.

 Ask the program contact: You can call or email the person listed under Contact 
Information to get answers to your questions.

Exploring the Grantee Profile
The Grantee Profile page provides access to the grant applications for which your organization is 
eligible and a great deal more useful information about grant programs than the old main page did.

After you log on to TEASE and select eGrants, you will see one of two Grantee Profile pages, 
depending upon your privileges:

 If you are an education service center (ESC) or a TEA employee, you will see the following 
page:

Type in either the county-district number or the Vendor ID for the district whose applications 
you would like to view, and then click Search. The Grantee Profile page for the district 
appears:
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 If you are any other kind of viewer, the Grantee Profile page for your organization or district 
appears immediately:
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The page contains the following panes:

 Available Grant Programs in eGrants: provides a list of and access to the grant programs 
for which your organization is eligible.

Each available program appears in this list until the date the application closes.

 Legend: provides the key to the icons that appear on the page.
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 eGrants Critical Events Due in Next 30 Days: shows events that are coming up within 
the next 30 days for all grants for which your organization is eligible.

Many of these events require action on your organization’s part. The events are organized in 
folders by grant program and show the name of the event and the due date.

 Messages: provides messages about down times and other system information. 

 eGrant Application Summary: contains the applications that your organization has in 
process, sorted by status.

Opening and Closing Folders

By default, the folders in some panes are open and some are closed. For example, most of the folders in 
the Grant Application Summary pane are closed. You have to open a folder to view its contents. To 
open a folder, click on the plus sign next to it. 

The plus sign changes to a minus sign. To close the folder, click on the minus sign next to it.

Folders throughout the eGrants interface work the same way.
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Understanding Status Information

Once you open a folder under eGrant Application Summary, you can see the organization name, 
the amendment version, and the status of the grant, as follows:

Status Description

Adjusting The application was unlocked by TEA to allow TEA staff to make changes to 
it. 

Available A blank application is available.

Awarded A grant was awarded and a NOGA issued.

Change Designation The application was unlocked by TEA to allow changes to the GS2200-
Shared Services Arrangement schedule. The Applicant Designation and 
Certification (ADC) form must be negotiated to make changes to the form 
before changing the application.

Delete Designation The application was unlocked by TEA to allow changes to the GS2200-
Shared Services Arrangement schedule to Not Apply at All. The Applicant 
Designation and Certification (ADC) form must be negotiated to make 
changes to the form before changing the application.

Draft The draft application is saved.

In Process The application is in review.

Negotiating The application was unlocked by TEA for you to make specific changes at 
the request of TEA.

NOGA Approved The application was approved by TEA.

Not Funded The competitive application was not approved for funding.

On Hold The application was placed on hold by TEA.

Received The application was received by TEA.

Rejected The application was rejected by TEA.

Submitted The application was submitted to TEA. You may not make changes once it is 
submitted.

Voided The amendment you submitted was not necessary and has been voided.
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Accessing a Grant

To access a new grant or a program that is still open, do the following:

1. On the Grantee Profile page, click the click the arrow under Available Grant Programs 
in eGrants and select the grant program from the list.

2. Click Initiate. This action opens the Grant Menu page for that grant.

You can also open it by clicking on the grant application name in the Grant Application Summary 
table and then clicking on an underlying file.

To view a document for a grant that is already retired, scroll down to the bottom of the Grantee 
Profile page, open the Archived Applications folder, and select it from the list.
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Touring the Grant Menu Page

Depending upon whether you are accessing a grant that is converted to the new eGrants interface or 
that is in the legacy interface, the Grant Menu page looks slightly different. The difference is that for 
legacy grants, the eGrants Application Table of Contents is replaced by an eGrants Application 
pane, which does not include the links to the schedules for completing the grant. If you want to 
complete the schedules, you must select the grant application name from the eGrants Application 
pane. This takes you to the Schedule Index page of the legacy eGrants. For more about that page, see 
Comparing the New and Legacy eGrants.

The Grant Menu page displays all the related forms and information for the grant program selected 
from the Grantee Profile main page.

Forms are grouped in the following categories, some of which are only visible if a form is available:

 eGrant Special Collections: lists and provides access to forms used to collect data related 
to the grant program. For example, if a report is required, it appears in this pane.
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 eGrants Designation Forms: lists and provides access to the Application Designation 
Certification (ADC) form and the Campus/Site Designation and Grant Writer Assignment 
(GWA) form for your grant, if applicable.

The grant application will not appear on this page until you have filled out and submitted the 
ADC form.

 eGrant Application: provides a summary of important information about the grant, 
including the date and time it is due to TEA.

The second portion of the eGrant Application pane provides access to and status for each 
application schedule.
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The rest of the page is organized in the following panes:

 Legend: provides a key to the icons used on this page

 Contact Information: provides program contact information for the grant. 

You can begin an e-mail message for the program contact by clicking on the e-mail address.

 Program Information: provides links to the application guidelines, the schedule 
instructions, announcements, and other pertinent information for the grant program.

 Calendar of Events: shows all the events, the reporting period if the event is a report, and 
the due date.

 Document Library: shows all of the documents associated with a grant that have been 
submitted and archived in Content Services. Documents are all those submitted as part of a 
grant application as well as reports and other forms. Clicking on the link opens the 
Document Library.
TEXAS EDUCATION AGENCY PAGE 35 



EGRANTS USER GUIDE REVISION 3.0
Checking the Calendar of Events

The Calendar of Events pane provides information about deadlines for the particular grant program. 
By default, the calendar is closed when you first open the page.

Click the plus sign next to the name to open the calendar:

The calendar opens to show all the upcoming events:

Note: It can take up to 24 hours for a submitted document to appear in the 
Document Library.
PAGE 36 TEXAS EDUCATION AGENCY 



EGRANTS USER GUIDE REVISION 3.0
 Event: the name of the event

 Reporting Period: the inclusive period for reports

 Due Date: the deadline for the activity or report

Completing Designation Forms

If the menu of schedules does not appear in the eGrants Application table of contents when you 
select a grant program, you must complete a designation form before you can have access to the 
application itself. The designation form may be an ADC form, which indicates your organization’s 
relationship to a shared service arrangement (SSA), or it may be a campus/site designation and grant 
writer assignment (GWA) form, which designates the campus or site and the author of the grant.

In any case, if a designation form is required, it appears under eGrants Designation Forms at the 
top of the Grant Menu page. 

Click on the form to open it. You must complete it and save it before you can open any schedule for the 
application.

Accessing Instructions or Other Documents

The Program Information pane on the Grant Menu page provides links to guidelines and 
instructions as well as other information related to the particular grant program. A copy of the eGrants 
Application Guidelines—Part 1: General and Fiscal Guidelines, which is applicable to all eGrants, is 
also available in the Program Information pane.

To open the instructions, guidelines, or other supporting documentation for the grant, click on the 
name of the document in the Program Information pane.
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Read all the application and program guidelines before starting the application. A good 
understanding of the rules and requirements of the grant and the eligible applicants will be crucial to 
the preparation of a grant application.

The instructions available from these links are the full instructions for the grant. You can also print 
instructions for a single schedule. The procedure for opening individual schedule instructions is 
different depending upon whether you are working with a grant in the new eGrants or one in legacy 
eGrants. See Comparing the New and Legacy eGrants.

Comparing the New and Legacy eGrants
Some grants have been converted to the new eGrants system. When you select a converted grant, the 
Grant Menu page looks like the one shown in New Interface. When you select a grant for a program 
that has not yet been converted, the Grant Menu page does not contain the list of schedules for the 
grant application. You must select the link to the application, and the Schedule Index page appears, 
like the one shown in Legacy Interface.

New Interface

Here is a sample Grant Menu page for the new eGrants interface. If you are working with a legacy 
application, the page looks the same except that the eGrants Application Table of Contents pane is 
replaced by the eGrant Application pane and does not show the list of schedules. Instead, the name of 
the grant application appears. See the chapter entitled Applying for a Grant.
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Legacy Interface

If you are working with a grant that is still in the legacy eGrants interface, the Grant Menu page does 
not contain the list of schedules. Instead, only the grant application name appears. You must click on 
the name of the grant and then a page such as the following appears.
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Applying for a Grant
Depending upon the grant, you may be using the new or legacy eGrants interface when you are 
working on a grant. 

Reviewing Grant Materials
The Program Information pane on the Grant Menu page provides links to information and 
instructions related to the particular grant program. The application is for informational purposes 
only. If the grant requires electronic submission, this application cannot be filled out and submitted to 
TEA. A copy of the Application Guidelines—Part 1: General and Fiscal Guidelines, which is applicable 
to all eGrants, is also available in the Program Information pane.

Click on the link to open a document or view a web site. Read all the application and program 
guidelines before starting the application. A good understanding of the rules and requirements of the 
grant and the eligible applicants will be crucial to the preparation of a grant application.

Remember that the instructions provided in eGrants are often general to many grants. Specific 
instructions for a step may be listed in Application Guidelines—Part 2: Program Guidelines and Use of 
Funds.

Selecting a Grant Program
Follow these steps to select a grant program.

1. If you have not already done so, open the Grantee Profile.

2. Select the grant program from the Available Grant Programs in eGrants list. This list 
shows all the grant programs for which your organization may be eligible.  

3. Click Initiate. The Grant Menu page opens:

Note: Before applying for a grant, always check the program guidelines for 
more details on eligibility and other information. 
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Once you have begun to fill out an application, you can also select it from the proper folder in the 
Grant Application Summary:

The folders are as follows:

 Draft Applications: The application is partially completed but has not yet been submitted.

 Submitted Applications: The application is complete and has been submitted to TEA. TEA 
staff members are in the process of reviewing the application.

 Application Requiring Negotiation: TEA has placed the application in a negotiation 
status and asked for changes. The application remains in this folder until you have 
resubmitted it.

 Awarded Applications: A grant was awarded and a Notice of Grant Award (NOGA) issued.

 Archived Applications: The grant period is past, and the grant is archived for future 
reference. The application remains in this folder for five years.

If the grant program you selected is competitive or allows SSAs, TEA requires you to complete 
an ADC or GWA form before you have access to the grant application. In this case, you will not 
see the list of application schedules in the eGrant Application table of contents pane. 
Instead, you will only see a link for the ADC or GWA form under eGrants Designation 
PAGE 42 TEXAS EDUCATION AGENCY 



EGRANTS USER GUIDE REVISION 3.0
Forms. Before you have access to the application, you must fill out the ADC form and submit 
it to TEA. The application schedules will appear in the list some time after you submit the ADC 
form.

Working with eGrants Schedules

Opening a Schedule

To work on an application, you must first have searched for and selected a grant program from the 
Grantee Profile.

The eGrants application consists of a set of schedules, or forms, that you must complete. These 
schedules are listed in the eGrant Application Table of Contents pane, divided by schedule type.

To begin working on the application, click on the name of Schedule GS2100—Applicant 
Information in the eGrant Application Table of Contents pane to open it. Until you complete 
Schedule GS2100, the other schedules are not available.

When you open a schedule, it locks to your use, so that no one can edit your copy of the form while you 
are using it. Once you close a schedule, the lock releases so that someone else in your organization can 
edit the same schedule.

Once the schedule opens, you can begin completing it. Click on the Instructions button at the top of 
the schedule page to see instructions for that schedule.

Note: The response to this application is binding for the entire project period. 
You are advised to complete the process of obtaining local board approval, as 
appropriate, before submitting this form.
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To submit an application, you must complete all required schedules. Required schedules are 
marked with an asterisk in the Required column.

Viewing Schedule Information

At the top of each application schedule is the schedule header showing information about the 
schedule. The header contains the following information:

 Schedule Status: the status of the schedule, as follows:

• Available or New: The schedule has not been saved.

• Incomplete: The schedule has been saved but some required fields are not complete.

• Complete: The schedule has been saved, and all required fields have text.

• Not Applicable: You have marked this schedule as not applicable to your application. If a 
form is not applicable to your application, you must open the schedule and check Not 
Applicable.

 Type of program: discretionary or formula

 Application ID: the number assigned to the application

 Organization: the name of your organization

 Campus/Site: the name of your campus or site, if applicable to the type of grant

 Vendor ID: your organization’s vendor ID number

 County-District: your organization’s county/district number

 ESC Region: the ESC region number for your organization

 School Year: the school year for the grant program

Note: You must enter and save some information in Schedule GS2100 to start 
the application process. By saving this basic information, you will be creating a 
working file for your application for this grant, which you are under no 
obligation to complete or submit. You may log on to eGrants as many times as 
you wish before the due date to work on your application. Once you submit an 
application, it is no longer available unless it requires revision by TEA.
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Filling Out the Schedule

Click Instructions to read the instructions for filling out the schedule. Some sections of schedules 
have a Help button for detailed information related to a particular field, and all of them have 
mouseovers that show explanatory text when your mouse hovers over a field.

The following are some tips for filling out the schedule form:

 Use the Tab key on your keyboard to move from field to field. 

 Do not use all caps. Type all text in upper- and lowercase. 

 Make sure all text fits in the allotted space. Many fields have a text count feature at the top of 
the pane. This feature tells you how many letters (including spaces) are permitted and how 
many you have left. Do not type more characters than are allowed.

The program will not save text that goes beyond the text count.

 Save each page as you enter data. Saving will prevent loss of data if you select the Cancel 
button or if system availability is temporarily interrupted.

 Tab out of a field to see any calculations on budget forms.

 Areas shaded in a light gray are fields populated automatically by the eGrants system, when 
applicable. Some of these fields are calculation totals-data pulled from sources outside the 
application-and some of these fields are populated with information entered elsewhere in the 
application. 

 Areas shaded in a dark gray are fields that are not required to be answered for that particular 
grant.

Note: The eGrants system will log you off  if there is no activity for 20 minutes. 
As with most software programs, remember to save your documents at regular 
intervals as you work on them. You will need to log back onto the system if you 
are logged off.
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Printing a Schedule

To print an individual schedule, click Printable Version. Doing so opens the page in a browser 
window that uses the standard controls found in Portable Document Format (PDF) documents. Use 
the PDF print capabilities to print the schedule.

1. Click on the printer icon.

2. Choose the printer.

3. Choose the pages you would like to print.

4. Type the number of copies you would like.

5. Define how you would like to scale the page to fit on the selected paper.

6. Make any other adjustments as needed.

7. Click Print.

Moving Around within a Schedule

Once you have opened an application or report, the following tips will help you work in eGrants:

 To select another schedule, click on the Select Schedule menu at the top of the page and 
select another schedule.

 Do not use the Back button on the browser. Use the navigation buttons provided on the form. 
Using the browser Back button can cause problems in processing the eGrants form.
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 Do not use the X button on the browser to exit a form or to exit Grantee Profile. Instead, 
return to the Grant Menu page by clicking on Application Menu and clicking Exit on the 
left margin.

 eGrants security disables the system connection to TEA if no activity is detected for 20 
minutes. This disconnection may not be evident until you attempt to save data. Any data 
entered after an automatic disconnection is lost. Save data often, and always save data when 
an interruption to your work may keep you from entering data for more than 20 minutes. 
Unless you want to discard data, always save it before returning to the table of contents. 

Saving the Schedule

You should save each schedule frequently to avoid losing data. To save the schedule, click Save at the 
top or bottom of the page.

Returning to the Grant Menu Page

To return to the Grant Menu page from any schedule, click Table of Contents at the top of the 
page.

Managing Your eGrants Application
Other activities you may want to perform regarding your application take place on the Grant Menu 
page. To return to the Grant Menu page from any schedule, click Application Menu.

Viewing Official TEA Time

It is important to pay attention to TEA time, because TEA will not accept applications or reports after 
5:00 p.m. TEA time on the day they are due. Use this time to ensure that any reports and applications 
are submitted by the official time. The due date for your application appears in the top of the Grant 
Application pane:

To view official TEA time, click on the TEA Time button at the bottom of the page: 
TEXAS EDUCATION AGENCY PAGE 47 



EGRANTS USER GUIDE REVISION 3.0
A window opens showing the official date and time:

Viewing Errors in Your Application

The Grantee Profile provides an easy way to view application errors. Click the View Errors button 
at the bottom of the page. A window opens listing the errors and providing the ability to print the page.
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Attaching Files

The grant program to which you are applying may require specific forms or other information to be 
attached to your application. Use this procedure to attach the files.

Naming Attachments

Name the files you are going to attach with no spaces (for example, 501C3letter.doc or 
5013C_letter.doc). Use a meaningful name that identifies the specific document.

Make sure that each attachment has a file extension (.pdf, .doc, .rtf, .xls, .bmp, .zip, .txt).

Scanning Documents

If a document must be scanned to create an electronic copy, use the following hints to ensure that the 
document size is as small as possible:

 Use an OCR or DPI setting of 200 DPI.

 Try to avoid creating .jpg files. If possible, create PDF documents with the scanner. 

Zipping Files

If your files are too large, add them to a zip file to save space. To download a free version of WinZip 
and find instructions on creating zip files, go to http://www.winzip.com/downwz.htm.

Adding Attachments
1. Click Attach File. The following attachment screen appears:

Note: The size of each attachment cannot exceed 10MB. If you have a larger 
file, use a different scanning setting or zip the file to make it take up less space.
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The required attachments are listed and described at the top of the dialog box. If you are 
attaching a document that is not listed, check Other.

2. In the Add Attachments pane, select the title of the attachment from the list, or if you 
selected Other above, type in the title.

3. Click the Browse button. A standard Windows browser appears. Find the file.

4. Click Attach.

5. Click Refresh to see the name of the document in the Documents Submitted in this 
Version pane.

6. Repeat this process to attach the rest of your documents.
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Viewing and Printing the Application

You can view and print the most recently saved version of the application, as follows:

1. Click View and print most recent saved version. The application opens as a PDF.

2. Print the application by selecting File > Print or by selecting the Print icon.

3. Print as you normally would.

Submitting the Application

Once you have completed the application and corrected all the errors, save it. Keep in mind the 
following when submitting an eGrants application: 

 An application cannot be submitted if it contains errors.

 An application can only be submitted once.

 A submitted application cannot be changed without filing an amendment.

 Only the organization’s authorized official can submit a grant application online via eGrants. 

If you are the author of the grant but not the authorized official, do the following:

1. Exit the application by clicking on Exit. 

2. Contact your authorized official (Grantee Official) to advise that the application is complete 
and ready for submission. Be sure to let the Grantee Official know which applications are 
ready to review and approve.

The authorized official then must do the following:

1. Log on to eGrants.

2. Search for and open the application.

3. Verify that the content of the application is correct.

4. Click the Certify and Submit button. The successful submittal will be confirmed.

5. Exit the application by clicking on Exit. 

Note: The login ID of the person pressing the Certify and Submit button 
must be that of the Organization Authorized Official that was submitted using 
the ADC form. This person must be the authorized official of the organization 
with authority to bind the organization in an agreement.
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Amending an Application

You cannot make changes to a submitted application without filing an amendment. Before you do so, 
however, make sure that an amendment is required or allowed for the change you want to make. To do 
so, consult the Schedule Instructions to see the conditions under which you may request an 
amendment. If you have any question about whether you should request an amendment, call or email 
the program contact.

Exiting the Application

Any time the application is open, if you wish to exit the application do the following:

1. Save the information if you would like the system to retain it.

2. Return to the Grantee Profile main page or the Grant Menu page if you have a schedule 
open.

3. Click on Exit.
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Managing the Application
This chapter covers the following application management activities:

 Amending an Application

 Revising an Application

 Accessing Progress or Compliance Reports

 Viewing Documents in the Document Library

 Exiting eGrants

Amending an Application
You cannot make changes to a submitted application without filing an amendment. Before you do so, 
however, make sure that an amendment is required or allowed for the change you want to make. To do 
so, consult the schedule instructions for Schedule GS2900—Purpose of Amendment to see the 
conditions under which you may request an amendment. If you have any question about whether you 
should request an amendment, call or email the program contact.

Revising an Application
The program area may request you to revise your application before it is accepted. In this case, your 
application will appear on the Grantee Profile page under Application Requiring Negotiation 
in the Grant Application Summary. Notes explaining the requested change will appear in form 
GS2300—Negotiation Comments and Confirmation.

Accessing Progress or Compliance Reports
If your grant requires a progress or compliance report, it appears some time before the deadline in the 
Grant Progress/Compliance Reports pane of the Grant Menu page. The Grant Menu page 
appears after you have selected a grant program from the Grantee Profile page and clicked 
Initiate.

The pane shows the following details:

 Form Description: the name of the report

 Status: the status of the report

 Due Date: the date the report is due

 ID: the identifying number for the report

To open the form, click on its name. Instructions for the form are available from the Instructions 
button. Some forms may also contain Help buttons for additional information.
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When you are finished completing the report, make sure that the official authorized to submit it, does 
so. Save it and submit it by clicking the Submit button.

Viewing Documents in the Document Library
The Document Library contains any grant-related documents that have been submitted in eGrants, 
including grant applications, their attachments and related documents such as applicant designation 
forms or grant writer assignment forms; NOGAs and related documents; reports; and special data 
collections. It can take up to 24 hours for these documents to appear in the list.

1. Log in to eGrants.

2. Select Grantee Profile from the main menu.

3. Select the grant program.

4. Open the Document Library dialog box by clicking on the link. If no documents are 
available yet, the following pane appears:

If at least one document is available, the following pane appears. The check boxes at the top of 
the box vary depending upon which documents are available in the library.
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5. If there is a grant application available, Grant Application is checked and the grant 
applications appear when the list appears. If you would like to view another type of document, 
check at least one  box from the possible document types.

6. Click Search.

The pane shows the following information about the documents:

 List of selected documents: header changes to show selections—title of documents

 Amd: the amendment version (00 means there has been no amendment.)

 Version: the version number of the document

 Date: the date the document was submitted

Exiting eGrants
To exit eGrants, do the following:

1. Save the information if you would like the system to retain it.

2. Return to the Grant Menu, Grant Application, or the Grantee Profile page if you are 
working in one of the schedules.

3. Click on Exit on the main menu.
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